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for general population (uncontrolled exposure). This device must be
installed to provide a separation distance of at least 20cm from all
persons and must not be collocated or operating in conjunction with
any other antenna or transmitter.
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1 Safety instructions and regulatory compliance

1.1 Operating instructions

* For a battery replacement, check the presence of a desiccant bag after an opening. This bag must be
replaced after a contact with ambient air during a period longer than 3 minutes. If the desiccant bag turn
green, it means you have to replace it (PN : H0Q00012).

¢ Only the use of ljinus' accessories and consumable ensures the best and the more safely installation.

¢ Do not mechanically force the housing.

1.2 Safety instructions

¢ Do not shake the devices.
¢ Do not physically modify the devices.
¢ Do not clean the devices with aggressive products like acetone. ‘ j;s | \
¢ Do not use batteries not recommended by ljinus (PN: AOG0O0010)
* The devices contain elements sensitive to electrostatic discharge.
Download your body from electrostatic loads before opening and manipulate the devices by touching a
metallic surface linked to the Earth.

¢ Do not shortcut, reload, pierce, warm, put into fire, crush the batteries |

1.3 Battery Safety

This product contains a lithium battery that must be disposed of properly.
Please follow the battery safety items below:

¢ Do not dismantle, open or shred secondary cells or batteries.

¢ Do not expose cells or batteries to heat or fire. Avoid storage in direct sunlight.

¢ Do not short-circuit a cell or a battery. Do not store cells or batteries haphazardly in a box or drawer where
they may short-circuit each other or be short-circuited by, other metal objects.

¢ Never try to recharge this non-rechargable batteries.

¢ Do not mix cells of different manufacture, capacity, size or type within a device.

* Seek medical advice immediately if a cell or a battery has been swallowed.

¢ Do not subject cells or batteries to mechanical shock.

¢ In the event of a cell leaking, do not allow the liquid to come in contact with the skin or eyes. If contact has
been made, wash the affected area with copious amounts of water and seek medical advice.

¢ Keep cells and batteries out of the reach of children.

¢ Keep cells and batteries clean and dry.

¢ Use only the cell or battery in the application for which it was intended.
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1.4 Warning to users in the United States

Federal Communication Commission Interference
Statement 47 CFR Section 15.105(b)

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates uses and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one of the
following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

This device , temperature data logger LT2, complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

NO UNAUTHORIZED MODIFICATIONS
47 CFR Section 15.21

CAUTION: This equipment may not be modified, altered, or changed in any way without signed written
permission from IJINUS. Unauthorized modification may void the equipment authorization from the FCC and
will void the JINUS warranty.

This device complies with FCC RF radiation exposure limits set forth for general population (uncontrolled
exposure). This device must be installed to provide a separation distance of at least 20cm from all persons and
must not be collocated or operating in conjunction with any other antenna or transmitter.

1.5 Warning to users in Canada / Attention pour les utilisateurs au Canada

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the following
two conditions: (1) this device may not cause interference, and (2) this device must accept any interference,
including interference that may cause undesired operation of the device.

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and
maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio
interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically
radiated power (e.i.r.p.) is not more than that necessary for successful communication. This device complies
with Industry Canada RF radiation exposure limits set forth for general population (uncontrolled exposure). This
device must be installed to provide a separation distance of at least 20cm from all persons and must not be
collocated or operating in conjunction with any other antenna or transmitter. This device has been designed to
operate with its own internal antenna and having a maximum gain of 0dBi.

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de
licence. L’exploitation est autorisée aux deux conditions suivantes: (1) il ne doit pas produire de brouillage, et
(2) l'utilisateur du dispositif doit étre prét a accepter tout brouillage radioélectrique recu, méme si ce brouillage
est susceptible de compromettre le fonctionnement du dispositif.
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Conformément a la réglementation d’Industrie Canada, le présent émetteur radio peut fonctionner avec une
antenne d’un type et d’un gain maximal (ou inférieur) approuvé pour I'émetteur par Industrie Canada.

Dans le but de réduire les risques de brouillage radioélectrique a I’ intention d’autres utilisateurs, il faut choisir
le type d’antenne et son gain de sorte que la puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas
I'intensité nécessaire a I'établissement d’'une communication satisfaisante. Cet appareil doit étre installé de
maniére a assurer une distance de séparation d'au moins 20 cm avec toutes les personnes. Il ne doit pas étre
installé dans un méme lieu ni étre utilisé avec une autre antenne ou un autre émetteur. Cet appareil a été
concu pour fonctionner avec sa propre antenne interne et avec un gain maximal de 0 dBi.
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2 Introduction

This device is a wireless temperature sensor. It is installed in places where temperature-sensitive products are
stored or shipped and need to be monitored. It is able to record temperature data in a memory. The recorded

data can be retrieved locally using a radio access point.

3 Necessary equipments

ijitemp

O

=
LT2 temperature MO0C0000-2 / WUIKEY-2
Data Logger Programming kits including

the software lJITempLab

CUliil BATTERY
= :

A0G00010
Non rechargeable lithium
battery 3.6V 2.6Ah for LT2

The LT2 data logger has an internal battery. To check or activate the radio connection, you can press the front
button. The LED flashes green by period every x seconds (depending on configuration). This LED indicates that

a radio connection is available with another device.

We have 2 choices of programming kit, at least one of them is necessary for local configuration by radio:

- Wiji kit (with its USB cable, antenna and software lJITemplLab 4.7) or

- Wiji key (USB/HF stick) that comes also with the software
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4 Configuration of the logger using the software lJITemplab 4.7

4.1 Launch the software lJITempLab 4.7 and connect to the data logger to configure

asl

File Tools  View
1) Connect to the Wiji AccessPoint
Connect

After connection of the Wiji kit equipped with its antenna (or the Wiji key) on the laptop or PC USB port, run the
software lJITemplLab.

NB: at least 1 meter distance is needed between the Wiji antenna and the datalogger for a correct radio
connection.

Click the “Connect” button so the software recognize the Wiji as a radio access point. If it doesn’t work you can
install the drivers from the top main menu, then Tools, and Install the Wiji driver :

a2l ljinus - UITemp Lab - w47 (WijiLib 2) - O X

File | Tools | View

1) Cu| Install the Wiji driver
Uninstall Wiji Driver

[,

Change Fifo Mode
Change sensor resolution

Retrieve sensor configuration

Once connected you have to click the Refresh visible sensors” and choose from the list the available sensors
nearby :

ol ljinus - NTemp Lab - v4.7 (Wijilib 2) — d X
File Tools  View
1) Connect to the Wiji AccessPoint 2) Choose a sensor

Disconnect Refresh visible sensors

W T2002-00000731 A
W T2005-00000031
[/ T2005-00000260
[JT3005-00000398
[JT3006-00005638
| T3006-00006345 N

The sensor or logger will be directly visible by its part number (SN) without the need to activate anything else

on the device. Locate the sensor's serial number (SN) on the sensor label (ex: 1JT3005-00000398). You can click
Serial number of the desired sensor to start the configuration :
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Eile

Tools

1) Connect to the Wiji AccessPoint

Auto export to csv to directory

View

2) Choose a sensor

Disconnect Refresh visible sensors
IJT2002-00000781 A
| T2005-00000031
| T2005-00000260
1T 3005-00000358
I T3006-00005628
I T3006-00006345 v

2) Launch an action on the sensor |JT3005-000003938
Begin Measures Measures interval : |0 = h (10 [ mn |0 =S
Test surles mesures © [ minimum | 0.00 maximum [35.00 2
Stop Measures And retrieve measures, delete then Read
retrieve data on the sensor and continue recording Measures

Choose the measuring period by setting the interval and click on the “Begin Measure” button:

2) Launch an action on the sensor [JT3005-00000398

. Begin Measures 1l

A pop up will appear confirming the recording state

4.2 Displaying the measures

Measures interval ;|0 = h |0 > mn |18
X
Recording begun on the sensor UT3005-000003%8

| 5

From the graph and/or list of data you find the tab “Export the measures” with the choice of different files

format and style.

You have 3 options to retrieve the data. Once retrieved, they are displayed on the graph

Stop Measures And

retrieve measures, delete then
retrieve data

Read
on the sensor and continue recording

Measures
Auto export to cav to directory

View Data

Measures from sensor |JT3005-00000398
from 11/15/2015 14:24:30t0 11/15/2019 14:29:30

[—— Temperature in “c from sensor |

a0 L. T N L L P L T
25 +
20 +
| | | | |
15/11/2019 15/11/2019 15/11/2019 15/11/2019
14:24:00 14:26:00 14:28:00 14:30:00

You can zoon into the graph with your cursor clicked. By passing your cursor along the curve you are able to

check the measures. To un-zoom the graph, right click and choose from the menu “Un-zoom”.
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From this menu you can also save the graph as an image, and other options.

View Data View Data
M f |JT3005-00000398 Measures from sensor [JT3005-00000358
frzfng#rrﬁ ;?Dﬁznigrza 30to 11/15/2019 14:35:00 from 11/15/2019 14:24:30t0 11/15/2019 14:35:00

[—— Temperaiure in "c from sensor [=— Temperaiure in *c from sensor
— — — — T T T T
— _— T T T T

Copy

26 ] 26 4 : Save Image As...
+: ; : : : : Page Setup...
: : Print...
24 :_ 24 4 : Show Point Values
: Un-Zoom
: . Undo All Zoom/Pan
: 22
22 +- Set Scale to Default

Export to csv

' ' ' ' ' 15/11/2019  15/11/2019  15/11/2019  15/11/2019  15/11/2019
15/11/2019  15/11/2019 15/11/2019  15/11/2019  15/11/2019 142500 142700 142800 143100  14-33.00

14:25:00 14:27:00 14:29:00 14:31:00 14:33:00

4.3 Data export

There are different ways of exporting the data :

- You can export the measures directly from the graph by right clicking on it, choosing from this menu “Export to
csv”.

- The same option is available from the top menu. Choose “File” and “Export to csv”.

- Finally to automatically export the data, choose a directory like bellow example :

Stop Measures And retrieve measures, delete then Read
retrieve data on the sensor and continue recording Measures

Auto export to csv to directory |C:\Users'\Michel'\Desktop

4.4 Menu options

File | Tools  View

Export to csv
Import a file
Quit

From the File menu you can

- Export data to csv

- Import a configuration file with data (.bin) from a sensor, even while not connected.
- Quit the software
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Tools | Wiew

Install the Wiji driver
Uninstall Wiji Driver

Change Fifo Mode

Change sensor resolution

Retrieve sensor configuration

a5l Change sensor resolution

Change sensor resolution

From the Tools menu you can

- Install the Wiji driver or uninstall it
- Change the memory recording mode

0-057TC
1-025°C
2-0.125C

cel

- Change the sensor resolution as desired
- Retrieve a sensor configuration

From the View menu you can hide the parameters to reveal the graph only in a bigger size

Hide parameters
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5 Revision of the document

Date Revision Writer(s) Modifications
D. MAHE . .
11/21/2019 2A01 A TRIBALLIER Creation of the document and translation
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